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Preface

Using Oracle Sales Cloud Adapter describes how to use the Oracle Sales Cloud adapter
in your SOA composite applications and Oracle Service Bus business services.

Topics:

• Audience

• Related Resources

• Conventions

Audience
Using Oracle Sales Cloud Adapter is intended for users who want to create, deploy, test,
and monitor applications that use the Oracle Sales Cloud adapter.

Related Resources
For more information, see these Oracle resources:

• Developing SOA Applications with Oracle SOA Suite

• Administering Oracle SOA Suite and Oracle Business Process Management Suite

• Administering Oracle Service Bus

• Understanding Technology Adapters

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

v





1
Introduction to Oracle Sales Cloud Adapter

This section introduces Oracle Sales Cloud adapter.

Topics

• Oracle Sales Cloud

• Installing the Cloud Adapters

• Performing Postinstallation Configuration Tasks

• Specifying the Oracle Sales Cloud WSDL

• Obtaining the Authentication Credentials

• Unsupported Features

• Restrictions

Oracle Sales Cloud
Oracle Sales Cloud enables modern selling with tools that are easy to deploy and use,
completely mobile, packed with powerful analytics, and built for collaborative selling
and revenue generation. Oracle Sales Cloud includes a set of features for creating and
tracking sales campaigns, developing leads into business opportunities, and pursuing
opportunities to generate revenue. Sales accounts, leads, and opportunities can be
automatically assigned to territories and sales teams.

The Oracle Sales Cloud adapter enables customers to easily integrate their on-premises
or SaaS applications with Oracle Sales Cloud without having to know the specific
details involved in the integration.

Integration with Oracle Fusion Applications may involve several design-time and
runtime considerations that require users to manually build and manage additional
logic into their integration for authentication, session management, fault handling,
data transformation mappings, and so on. The Oracle Sales Cloud adapter reduces the
cost of building and maintaining this complex logic with out-of-the-box features such
as a graphical, point-and-click, wizard-based designer. The Oracle Sales Cloud
connection:

• Generates automatic mapping to the exposed business object or event subscription
that you select during adapter configuration:

– Business object: Represents a self-contained business document that can be
acted upon by the integration. An integration can send requests to create a new
record for that business object. They can send a request either to update or
delete an existing record for a business object. Integrations can also send
requests to retrieve information about one or more records representing that
business object.
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– Event subscription: Represents an event document to which you subscribe. The
event subscription is raised by the Oracle Sales Cloud application.

• Interacts at runtime with the publicly-exposed Oracle Sales Cloud business objects
or event subscription to perform operations defined on them.

• Provides contextual information to the developer at design time about the business
objects and services available for integration.

• Provides custom objects, both standalone and child, that are referenced indirectly
in the Oracle Sales Cloud service WSDL. These objects are presented as first-class,
strongly-typed objects.

For more information, see Configuring Oracle Sales Cloud Properties.

Installing the Cloud Adapters
The cloud adapters are automatically installed with Oracle SOA Suite.

After you complete adapter installation, perform the tasks described in Performing
Postinstallation Configuration Tasks.

Note:   For information about supported versions and platforms, see the
release certification matrix at Supported System Configurations.

Performing Postinstallation Configuration Tasks
You must perform postinstallation configuration tasks after installing the cloud
adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud
Adapters Postinstallation Configuration Guide.

Specifying the Oracle Sales Cloud Service Catalog Service WSDL or
Event Catalog URL

You must specify a mandatory Oracle Sales Cloud service catalog service WSDL (for
accessing business objects) and optionally an event catalog URL (for accessing event
subscriptions).

A mandatory Oracle Sales Cloud service catalog service WSDL is required for
accessing business objects. You can also optionally specify an event catalog URL for
accessing event subscriptions. The service catalog service WSDL is required to
configure the adapter for both inbound and outbound endpoints using either business
objects or business services. The event catalog URL is required for configuring the
inbound adapter for event subscriptions.

Installing the Cloud Adapters
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Obtaining the Service Catalog Service WSDL

WSDL Requirements Where Do You Get the WSDL?

The URL must be that of a service catalog
service WSDL. The service catalog service is a
Fusion Application service that returns a list
of external services available for integration.
It allows clients to retrieve information about
all public Fusion Application service
endpoints available for that instance.

The service catalog service enables clients to
retrieve information about all public Oracle
Fusion Application service endpoints
available for that instance. The information it
returns is specific to the particular cloud
instance and also reflects the new services
that may have been introduced in patches
applied to the instance. This service is used to
programmatically discover the SOAP services
available on the cloud instance and retrieve
the necessary metadata to invoke the SOAP
services to manage business objects.

The developer creating an Oracle Sales Cloud
connection must work with the Oracle Sales
Cloud service administrator to get the
concrete WSDL URL for the service catalog
service provisioned for the specific SaaS
application.

This section describes how to derive the external virtual host and port for a tokenized
service catalog service WSDL. The topology information in the Topology Registration
setup task contains the external virtual host and port for the domains and applications.
The following instructions describe the steps for deriving the values using the service
catalog service WSDL URL as an example: https://atf_server:port/
fndAppCoreServices/ServiceCatalogService.

To access the Review Topology page, the
ASM_REVIEW_TOPOLOGY_HIERARCHY_PRIV entitlement must be granted to the
user’s job role. The entitlement is granted to the
ASM_APPLICATION_DEPLOYER_DUTY duty role, which is inherited by the duty
roles ASM_APPLICATION_DEVELOPER_DUTY and
ASM_APPLICATION_ADMIN_DUTY.

If the menu items and tasks described in the following procedure are not available in
your cloud instance, your user account is missing the required role. Contact your
cloud instance security administrator for assistance.

1. Log in to the cloud instance.

2. Click the Navigator icon in the global area in the top part of the window, then
chose Setup and Maintenance under the Tools heading.

3. Select Review Topology under the Topology Registration section in the Tasks
regional area on the left side of the window.

4. Click the Detailed tab in the middle of the window.

The tab shows the list of domains configured in the cloud instance.
 

Specifying the Oracle Sales Cloud Service Catalog Service WSDL or Event Catalog URL
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5. Map the token name for the service path value to the domain name in the
Topology Manager:

Token Name in Service Path Domain Name

atf_server CommonDomain

crm_server CRMDomain

fin_server FinancialDomain

hcm_server HCMDomain

ic_server ICDomain

prc_server ProcurementDomain

prj_server ProjectsDomain

scm_server SCMDomain

6. Expand the domain name and select any external virtual host and port for the
J2EE applications that are deployed on the domain. In the sample window, the
values for this particular instance are fs-your-cloud-hostname and 443,
respectively.
 

Specifying the Oracle Sales Cloud Service Catalog Service WSDL or Event Catalog URL
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7. Replace the domainName_server:PortNumber with the external virtual host
and port identified in the previous step. For example:

https://fs-your-cloud-hostname:port/fndAppCoreServices/
ServiceCatalogService?wsdl

Obtaining the Event Catalog URL

You must know the customer relationship management (CRM) URL format to access
the CRM application user interface. Follow the URL format to determine the event
catalog URL. For example, if the CRM URL format is:

https://fusxxxx-crm-ext.us.oracle.com/customer/faces/CrmFusionHome

Then the event catalog URL is:

https://fusxxxx-crm-ext.us.oracle.com/soa-infra

Note:   If you subscribe to an event on the Request page of the Adapter
Configuration Wizard, you must then manually update the inbound JCA file
in the Application_Name/Project_Name/SOA/Adapters/ directory
with the following details:

<property name="csfkey" value="osc"/>
   <property name="csfMap" value="oracle.wsm.security"/>

This is because even though you specified CSF details on the Create CSF Key
page of the Adapter Configuration Wizard, these details were not added to
the JCA file. When you then attempt to deploy the composite that includes the
inbound event subscription, it fails. Manually updating the inbound JCA file
enables deployment to be successful.

Specifying the Oracle Sales Cloud Service Catalog Service WSDL or Event Catalog URL
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Obtaining the Authentication Credentials
Obtain the user name and password that are required for creating the Credential Store
Framework (CSF) authentication key in Oracle JDeveloper from your SOA domain
administrator. These credentials are required for most cloud adapters.

If you are configuring the Oracle Eloqua Cloud adapter, the credentials require three
properties (company, username, and password).

Unsupported Features
The adapter does not support the following features:

• Adapter runtime retry configuration properties such as jca.retry.count,
jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval.

• Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion
Middleware Control.

• The display of properties in the Properties tab for a reference (outbound) adapter
in Oracle Enterprise Manager Fusion Middleware Control (for example, service
WSDL URL, CSF key used, and others). These are the reference adapters that you
select on the Services and References page.

• Rejected message handling

• Metrics such as the number of invocations.

• The following message encryption and decryption features available when you
right-click a cloud adapter in the Exposed Service swimlane or External
References swimlane in Oracle JDeveloper:

– Protect Sensitive Data > Encrypt Request Data for cloud adapters in the
Exposed Service swimlane.

– Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the
External References swimlane.

• The policy attachments feature available when you right-click a cloud adapter in
the Exposed Service swimlane or External References swimlane in Oracle
JDeveloper.

Restrictions
Note the following restrictions:

Not all Oracle Fusion Application services are available in SaaS mode because the
Oracle Fusion Application topology splits visibility to web and service resources into
two categories: internal and external. Therefore, some services are internal and cannot
be used by the adapter for integration. Only external services are available for public
consumption.

The adapter cannot be used for integrating the interfamily modules, because services
defined on them are not external services.

Obtaining the Authentication Credentials
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2
Understanding Oracle Sales Cloud Adapter

Features

The Oracle Sales Cloud adapter provides the following features.

Topics

• Adapter Architecture

• Custom Business Objects

• Understanding Oracle Sales Cloud Adapter Design Integration Patterns

• Designing an Integration with the Adapter Configuration Wizard

• Monitoring Your Application During Runtime

Adapter Architecture
The adapter includes the following key features.

Service Catalog Service

The WSDL URL that you specify during adapter configuration must be that of a
service catalog service WSDL. The service catalog service is a Fusion Application
service that returns a list of external services available for integration. The service
catalog service provides the following features:

• Provisioned on the cloud instance.

• Provides public external service information for the specific cloud instance. It
reflects new services introduced in patches and customizations.

• Gets the endpoint and metadata for public external services on the cloud instance
on which the service catalog service is provisioned. The information that it returns
is specific to the particular cloud instance and reflects new services that may have
been introduced in patches applied to the instance. Oracle Fusion Applications in
the Oracle Applications cloud enable partners and customers to use this service to
programmatically discover the SOAP services available on the cloud instance and
retrieve the necessary metadata to invoke the SOAP services to manage business
objects.

Business Objects

The business object that the service implements is composed of a hierarchy of logical
entities that contain a collection of attributes. As an example, the opportunity service is
defined on the opportunity business object. The opportunity business object consists of
many entities such as an opportunity contact and opportunity lead. The business
object is the functional object on which the service operates. Examples include
opportunity, sales account, sales lead, marketing campaign, and sales forecast. 
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Event Subscriptions

Event subscriptions represent an event document to which you subscribe. The event
subscription is raised by the Oracle Sales Cloud application.

Business Object Notation

The business objects are grouped into related objects that are in turn grouped into
higher-level related objects. For example, the opportunity service business object
contains the following value:

• CRM : Opportunity Management : Opportunity

The above value means the service operates on the opportunity object. The
opportunity object is grouped into a related set of objects called opportunity
management that in turn is grouped into a larger set of related objects called CRM
(Customer Relationship Management). Other business objects included in the
opportunity management grouping are sales method and sales revenue. Other logical
business object groups in CRM are lead management and partner management.

Life Cycle of Business Object Services

The business object service goes through three life cycle phases:

• Active: This phase starts when the service is first delivered and lasts until it is
deprecated. 

• Deprecated: A service may be deprecated when it is superseded by a newer version
of the service or there is a planned obsolescence in a future release. The deprecated
status means that the service is still supported, but becomes obsolete in a later
release.

Deprecated services do not mean they are not supported. They continue to be
supported until they become obsolete. Deprecated services must go through the
deprecation cycle during which users are told that the service is going to be
withdrawn at a future time. However, it is still a service that must be supported.

If a selected business object or service has a life cycle value of deprecated, a
warning message is displayed. If the business object or service captures
information about a replacement business object or service, then it may also be
displayed. This information comes from the annotation element in the service’s
WSDL.

A portion of a service WSDL is shown below.

<wsdl:documentation xmlns:oer="http://xmlns.oracle.com/oer">
<name>Opportunity Service</name>
<description>A service to create, update, get, find, or delete opportunities.
 WARNING: This service will be deprecated and replaced with a newer version in 
the upcoming release.</description>
<oer:lifecycle>Active</oer:lifecycle>
<oer:compatibility>Supported - Backward Compatibility Assured</oer:compatibility>
. . .
<oer:category name="lbo">
<value>CRM-CRM : MOO-Opportunity Management : MOO_OPPORTUNITY-Opportunity</value>
</oer:category>
</wsdl:documentation>

New service consumers should consume the newer active version of the service
and existing customers should migrate to the newer active version of the service.

• Obsolete: The service is no longer shipped or supported. 

Adapter Architecture
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Supportability

The public external SOAP services are supported throughout their life cycle until they
are obsolete. Conversely, services that are considered private and not intended for
partners and customers to consume are not supported.

Cloud Services

The cloud web services (for example, for Oracle Sales Cloud or Oracle HCM Cloud)
provide access to an application programming interface (API) that companies can use
to build programs to integrate with the cloud (for example, Oracle Sales Cloud or
Oracle HCM Cloud). The API consists of a set of WSDL files that describes the
interface to the cloud objects. This provides a programmatic interface for accessing
cloud information (for example, for Oracle Sales Cloud or Oracle HCM Cloud). A
customer application can use the WSDL files through standard web services
development tools. The web services API allows companies to build programs to
integrate with the cloud (for example, Oracle Sales Cloud or Oracle HCM Cloud).

Some common examples of client integrations include integrations of CRM and back-
office applications. You can retrieve real-time sales and marketing information from
the cloud (for example, Oracle Sales Cloud or Oracle HCM Cloud) and use it in
financial and other back-office applications. For example, you can retrieve information
about recently closed opportunities through the web services interface and insert this
information into an order entry system that has a web services user interface. In
addition, you can store information from back-office applications for instant access by
users, which is visible in custom fields.

Security

Prior to accessing the fusion web services, user credentials must be supplied in
compliance with the security policies attached to the cloud services (for example,
Oracle Sales Cloud or Oracle HCM Cloud). Upon successful authentication, the user is
logged in and can issue web service requests to access and retrieve data. All cloud web
services are stateless (for example, Oracle Sales Cloud or Oracle HCM Cloud) such
that each web service call is an atomic transaction and is not associated to a persistent
session. Management of the stateless web service calls is handled by the underlying
fusion framework and is abstracted from the end user.

Custom Business Objects
The adapter includes support for custom business objects.

Custom objects are similar to user-defined objects, which are added by the user in the
deployed instance.

Custom objects and custom attributes have "_c" appended to their names. Custom
objects are exposed using a generic service interface. The custom object web service
contains generic operations to which the custom object is passed as a parameter.
Examining the schema that is referenced by the service WSDL shows the details of the
parameters of the available operations.

Custom Business Objects
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Understanding Oracle Sales Cloud Adapter Design Integration Patterns
Oracle Sales Cloud adapter supports the following design integration patterns in the
Adapter Configuration Wizard.

Outbound Integration from Oracle Sales Cloud Adapter into the Oracle Sales
Cloud Application

• You configure the Oracle Sales Cloud adapter to connect to the Oracle Sales Cloud
application.

• You navigate through the set of available business objects (standard and custom)
and event subscriptions and select an operation to invoke the object. You can also
use the search facility to locate a business object.

• You save the adapter configuration and exit the Adapter Configuration Wizard.

• You map the application business object with the logical business object of Oracle
Sales Cloud.

• You complete the design of the SOA composite application.

At runtime, the SOA composite application performs the selected operation on the
business object on Oracle Sales Cloud using the Oracle Sales Cloud adapter.

Inbound Integration into Oracle Sales Cloud Adapter from the Oracle Sales
Cloud Application

The Oracle Sales Cloud adapter can also be configured for inbound connectivity. For
example, you may want to integrate an on-premise application with the Oracle Sales
Cloud application by defining an inbound service interface using the Oracle Sales
Cloud adapter. This service is then invoked by Oracle Sales Cloud.

• You define an inbound service interface to be invoked by Oracle Sales Cloud.

• You configure a service endpoint by browsing through a list of objects. You select
the business object to receive from Oracle Sales Cloud as a request payload to this
SOA composite application.

• You complete the Oracle Sales Cloud adapter configuration.

• You complete the design of the SOA composite application as per the business
requirements.

Designing an Integration with the Adapter Configuration Wizard
You use the Adapter Configuration Wizard to include the Oracle Sales Cloud adapter
in a SOA composite application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to
select the artifacts required to communicate with the Oracle Sales Cloud application.
You can configure the adapter in the inbound (source) direction or the outbound
(target) direction.

Note:   If the Localize Files dialog is displayed during adapter configuration,
click Cancel. You cannot localize the WSDL file.

• Inbound (source) direction:

Understanding Oracle Sales Cloud Adapter Design Integration Patterns
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– The Basic Info page prompts you to enter a meaningful name and optional
description.

– The Connection page prompts you to specify the WSDL, security policy
(username password token), and CSF authentication key to use. The
authentication key is created by clicking the Add icon to specify the key name,
user name, and password.

You can also test the connection to the Oracle Sales Cloud application on the
Connection page. This enables you to confirm that the URL to the service
catalog service and credentials are correct. Status is displayed that indicates
whether the connection is successful and whether the credentials are
authenticated by the Oracle Sales Cloud application. Any errors that occurred
during the attempt to connect are also displayed.

– The Request page prompts you to select the business object or event
subscription to receive as a request from the Oracle Sales Cloud application.

Note:   

◆ When you select a business object in the inbound direction, a description is
displayed below the table, but life cycle information about the selected
object (for example, active or deprecated) is not displayed. In the outbound
direction, life cycle information for the business object is displayed.

◆ No callback is expected in case of event subscriptions. Therefore, you must
select None as the response on the Response page.

To get all available data objects in the Oracle Sales Cloud instance, the adapter
first reads the schema document (.XSD) that is referenced in the service’s WSDL.
The adapter then parses this XSD to obtain the list of all schema imports and
shows them as data objects.

For example, the adapter displays the opportunity business object and its useful
metadata first by reading the opportunity service’s WSDL and the referenced
schema OpportunityService.xsd file. The XSD in turns imports another
schema Opportunity.xsd in which the opportunity business object is
defined. The metadata for the opportunity business object is defined in this
schema.

A search facility is provided that enables you to filter the display of business
objects for quick selection. When you enter a search string, the list renders only
the matching business objects in the list browser instead of showing all objects.

– The Response page prompts you to select the business object for the integration
to send as a response document to the Oracle Sales Cloud application. To send
no response, select None. You can also optionally select to send an immediate
response back to the Oracle Sales Cloud application. An immediate response
indicates a conversational response. For an immediate response, you can select
any of the data objects as a response document.

– The Summary page displays your selections from the previous pages.

• Outbound (source) direction:

– The Basic Info page prompts you to enter a meaningful name and optional
description. This is the same page that is displayed in the inbound direction.

Designing an Integration with the Adapter Configuration Wizard
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– The Connection page prompts you to specify the WSDL, security policy (none,
basic authentication, or username password token), and CSF authentication key
to use. This is the same page that is displayed in the inbound direction.

The Operations page prompts you to select a business object or service and the
operation to perform on your selection.

A search facility based on service names is also provided. To quickly select a
business service, you type a search string. The list renders only matching
business services in the list browser instead of showing all services.

– The Summary page displays your selections from the previous pages.

The following artifacts are created for each adapter instance and displayed in the
Applications window in Oracle JDeveloper:

• WSDL file: Provides a simplified user experience in terms of creating data
mappings, while integrating with the Oracle Sales Cloud application services. For
example, an abstract WSDL defines strongly-typed types, the name of the
operation and business object selected, and the request and response structures.

• JCA file: Contains the internal implementation details used by the adapter during
runtime. It contains the different interaction and connection properties used by the
adapter.

When application configuration is complete, you can deploy the application from
Oracle JDeveloper to the runtime environment.

Note:    The wizard does not support the creation of response message
callbacks. As an alternative, you can design your BPEL process to include
activities that support callbacks.

Note:   If you re-edit an already configured Oracle Sales Cloud adapter service
or reference, the service catalog WSDL is replaced with the service URL. You
must re-enter the service catalog WSDL for the adapter to work correctly.

For information about the details to specify in the fields of the wizard pages, see 
Configuring Oracle Sales Cloud Properties.

Monitoring Your Application During Runtime
You can monitor your application from the runtime environment.

You use the runtime part of the adapter for delivering the information generated
during design time to the service endpoint. You can monitor your SOA composite
application or Oracle Service Bus business service from Oracle Enterprise Manager
Fusion Middleware Control. You can also test and monitor your Oracle Service Bus
business service from Oracle Service Bus Console. However, you cannot monitor the
service and reference metrics for the adapters in Oracle Enterprise Manager Fusion
Middleware Control.

Monitoring Your Application During Runtime
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3
Designing SOA Composite Applications

This section describes how design a SOA composite application with the Oracle Sales
Cloud adapter in Oracle JDeveloper.

Topics

• Creating a SOA Composite Application

• Adding an Adapter to a SOA Composite Application as a Service or Reference

• Completing Design of a SOA Composite Application

Creating a SOA Composite Application
This section provides an overview of how to create a SOA composite application in
which to include the adapter as an exposed service or external reference.

1. Start Oracle JDeveloper.

2. From the File menu, select New > Application.

3. In the New Gallery dialog, select SOA Application from the Items list, then click
OK. The SOA Create SOA Application wizard is displayed.

4. Specify an application name, and click Next.

5. Specify a project name, and click Next.

6. Select Composite with BPEL Process, and click Finish.

The SOA composite application is displayed for designing in the SOA Composite
Editor.

Adding an Adapter to a SOA Composite Application as a Service or
Reference

You can add an Oracle Sales Cloud adapter to a SOA composite application as an
inbound (source) service to the Exposed Services swimlane or as an outbound (target)
reference to the External References swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your SOA composite application.

2. Go to the Cloud section under Custom/Third Party.

The adapters are displayed.
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3. Drag the adapter to the appropriate swimlane:

a. To create an inbound (source) service, drag the adapter to the Exposed Services
swimlane, and see the following sections that describe the wizard pages for
configuring the adapter:

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Sales Cloud Source Request Properties

• Configuring Oracle Sales Cloud Source Response Properties

• Reviewing Configuration Values on the Summary Page

b. To create an outbound (target) reference, drag the adapter to the External
References swimlane, and see the following sections that describe the wizard
pages for configuring the adapter.

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Sales Cloud Target Operations Properties

• Reviewing Configuration Values on the Summary Page

Adding an Adapter to a SOA Composite Application as a Service or Reference
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Completing Design of a SOA Composite Application
This section provides an overview of how to complete design of your SOA composite
application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

a. Connect the BPEL process to the adapter. For this example, the BPEL process is
connected to the adapter as an external reference.
 

 

b. Design the contents of the BPEL process. For example:

i. Double-click the BPEL process.

ii. Add and configure an invoke activity to invoke the adapter.
 

Completing Design of a SOA Composite Application
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iii. Add and configure assign activities to copy the contents of one variable to
another when sending and receiving messages to and from the adapter.
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iv. Add and configure other activities, as appropriate.

When complete, view the SOA composite application in the SOA
Composite Editor.

For specific information about creating and designing SOA composite applications,
see Developing SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:

a. In the navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite
application to the application server.

Completing Design of a SOA Composite Application
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4
Designing Oracle Service Bus Business

Services

This section describes how to design an Oracle Service Bus business service with the
adapter in Oracle JDeveloper.

Topics

• Creating an Oracle Service Bus Business Service

• Adding an Adapter to a Business Service as a Service or Reference

• Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service
This section provides an overview of how to create an Oracle Service Bus business
service in which to include the adapter in Oracle JDeveloper.

1. Start Oracle JDeveloper.

2. From the File menu, select New > Application.

3. In the New Gallery dialog, select Service Bus Application from the Items list, then
click OK.

4. Specify an application name, and click Next.

5. Specify a project name.

6. Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle
Service Bus Overview Editor.

Adding an Adapter to a Business Service as a Service or Reference
You can add the adapter to an Oracle Service Bus business service as an inbound
(source) proxy service to the Proxy Services swimlane or as an outbound (target)
external service to the External Services swimlane in Oracle JDeveloper.

Note:   If the Import OSB Resource dialog is displayed during adapter
configuration, click Cancel. You cannot localize the WSDL file.

1. Go to the Component Palette in your Oracle Service Bus business service.

2. Go to the Cloud section under Service Bus.
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The adapters are displayed.
 

 

3. Drag the adapter to the appropriate swimlane:

a. To create an inbound (source) proxy service, drag the adapter to the Proxy
Services swimlane, and see the following sections that describe the wizard
pages for configuring the adapter:

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Sales Cloud Source Request Properties

• Configuring Oracle Sales Cloud Source Response Configuration Properties

• Reviewing Configuration Values on the Summary Page

b. To create an outbound (target) external service, drag the adapter to the External
Services swimlane, and see the following sections that describe the wizard
pages for configuring the adapter:

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Sales Cloud Target Operations Properties

• Reviewing Configuration Values on the Summary Page

Adding an Adapter to a Business Service as a Service or Reference
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Completing Design of an Oracle Service Bus Business Service
This section provides an overview of how to complete design of your Oracle Service
Bus business service and deploy the application.

1. Design the contents of your Oracle Service Bus business service. For example, to
configure an Oracle Service Bus proxy service in your business service:

a. In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins
lane and select Insert > Pipeline.

The Create Pipeline Service dialog is displayed.

b. Enter a name for the pipeline and select the project location, then click Next

c. Select WSDL as the Service Type.

d. To the right of the WSDL selection, click the Browse icon to select the WSDL.

e. Select Application.

f. Expand Resource Chooser and select the WSDL file, then click OK.

g. Ensure that Expose as a Proxy Service is selected.

h. From the Proxy Transport list, select http, then click Finish.

The Pipeline component is displayed in the Oracle Service Bus Overview
Editor.

i. Connect the external service to the Pipeline component.

For more information about creating and designing an Oracle Service Bus business
service, see Developing Services with Oracle Service Bus.

2. Open the pipeline that shows the default routing.

3. Verify the service and corresponding operation are displayed in the Routing
Properties tab at the bottom of the dialog.

The outbound project is ready for deployment.

4. Deploy the business service.

a. Select the project, then select Deploy to Service Bus Server.

b. Follow the steps in the deployment wizard.

Completing Design of an Oracle Service Bus Business Service
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5
Configuring Oracle Sales Cloud Properties

The Oracle Sales Cloud adapter enables you to create integrations with an Oracle Sales
Cloud application.

The following sections describe the wizard pages that guide you through
configuration of the Oracle Sales Cloud adapter as a source and target in an
integration.

Topics

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Sales Cloud Source Request Configuration Properties

• Configuring Oracle Sales Cloud Source Response Configuration Properties

• Configuring Oracle Sales Cloud Target Operation Properties

• Reviewing Configuration Values on the Summary Page

For more information about Oracle Sales Cloud, see Oracle Sales Cloud.

Configuring Basic Information Properties
You can enter a name and description on the Basic Info page of each source and target
adapter in your integration.

Topics

• What You Can Do from the Basic Info Page

• What You See on the Basic Info Page

What You Can Do from the Basic Info Page
You can specify the following values on the Basic Info page. The Basic Info page is the
initial wizard page that is displayed whenever you drag an adapter to the trigger
(source) or invoke (target) area supported by your adapter.

• Specify a meaningful name.

• Specify a description of the responsibilities.
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What You See on the Basic Info Page
The following table describes the key information on the Basic Info page.

Element Description

What do you want to call your endpoint? Provide a meaningful name so that others can
understand the responsibilities of this
connection. You can include English
alphabetic characters, numbers, underscores,
and dashes in the name. You cannot include
the following:
• Blank spaces (for example, My Inbound

Connection)
• Special characters (for example,  #;83& or

righ(t)now4)
• Multibyte characters

What does this endpoint do? Enter an optional description of the
connection’s responsibilities. For example:
This connection receives an

inbound request to synchronize

account information with the

cloud application.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
Enter the Oracle Cloud adapter configuration connectivity and Credential Store
Framework (CSF) key values for your integration.

Topics

• What You Can Do from the Oracle Cloud Adapter Connection Page

• What You See on the Oracle Cloud Adapter Connection Page

• What You Can Do from the Oracle Cloud Adapter CSF Key Page

• What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page
You can specify the following connection values for the Oracle Cloud adapter.

• Specify the WSDL URL for some adapters. If you are configuring the Oracle Eloqua
Cloud adapter, no WSDL is required.

• Specify the security policy.

• Create the authentication key. A key created for one direction (for example,
outbound) is also available for selection in the other direction (for example,
inbound).

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
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What You See on the Oracle Cloud Adapter Connection Page
The following table describes the key information on the Oracle Cloud adapter
Connection page.

Element Description

WSDL URL Note: This field is not displayed for the
Oracle Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to
build integrations specific to your instance.
You can also select the WSDL from a file
system or another source by choosing the
browser icon next to the WSDL URL field.
Click File System at the top of the dialog,
then browse for the WSDL.

Security Policy Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

• The wizard shows all policies, including
those that may not be applicable. To make
a correct selection, you must have a
knowledge of policies. For example, you
cannot select a SAML-based policy
because the identity is not propagated.

• The policies you apply to the cloud
adapter are unique to the cloud adapter
and do not impact other endpoints in the
composite.

Authentication Key Select the CSF authentication key.

• Add: Click to create a new authentication
key. You must specify the key name, user
name, and password.

• Edit: Click to edit an authentication key.
• Delete: Click to delete an authentication

key.

Test Click to validate the authentication key.

What You Can Do from the Oracle Cloud Adapter CSF Key Page
You can specify the following CSF key values for the Oracle Cloud adapter.

• CSF key name

• User name and password

• If you are configuring the Oracle NetSuite Cloud adapter only, you must specify an
email account and role.

• If you are configuring the Oracle Eloqua Cloud adapter only, you must specify a
company name.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties

Configuring Oracle Sales Cloud Properties  5-3



What You See on the Oracle Cloud Adapter CSF Key Page
The following table describes the key information on the Oracle Cloud adapter CSF
Key page.

Element Description

CSF Key Name Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password
required for authentication with the
application (for example, the Oracle Sales
Cloud or Oracle ERP application). This key
identifies your login credentials during
design-time.

Company Name (Oracle Eloqua Cloud
adapter only)

Note: This field is only displayed for the
Oracle Eloqua Cloud adapter.

Specify the Oracle Eloqua company name.

Email , Account and Role Note: This field is only displayed for the
Oracle NetSuite Cloud adapter.

Specify the email account and role.

User Name Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle ERP application). Your
administrator provides you with user
credentials.

Password Enter the password for connecting to your
application.

Re-enter Password Re-enter the same password a second time.

Configuring Oracle Sales Cloud Source Request Properties
Enter the Oracle Sales Cloud connection source request values for your integration.
The values you specify start the integration.

Topics

• What You Can Do from the Oracle Sales Cloud Source Request Page

• What You See on the Oracle Sales Cloud Source Request Page

What You Can Do from the Oracle Sales Cloud Source Request Page
You can select the following source request values for the Oracle Sales Cloud
application.

Select the specific type to receive as a request from Oracle Sales Cloud. Your ability to
select either a business object or event subscription is based on the content of the

Configuring Oracle Sales Cloud Source Request Properties
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WSDL file (for business objects) or event catalog URL (for event subscriptions) you
specified during Oracle Sales Cloud adapter configuration.

• Select to receive a business object as a request from Oracle Sales Cloud. This
selection invokes the integration.

• Select to receive an event subscription raised by the Oracle Sales Cloud application
as a request from Oracle Sales Cloud. This selection invokes the integration.

What You See on the Oracle Sales Cloud Source Request Page
The following table describes the key information on the Oracle Sales Cloud adapter
source Request page.

Element Description

Configure a Request Select the request type appropriate to your
integration. The fields that are displayed
below are based on the request type that you
select.

• With Business Objects: Select to display
a list of business objects.

• With Business Events: Select to display a
list of event subscriptions

Select a Business Object

(is displayed if With Business Objects is
selected)

Select the business object from the Oracle
Sales Cloud application to receive as a
request that starts the integration.

Business Event For Subscription

(is displayed if With Business Events is
selected)

Select the event subscription from the Oracle
Sales Cloud application to which to
subscribe. This event is received as a request
that starts the integration.

Filter Expr for Business_Event_Name

(is displayed if With Business Events is
selected)

Enter an event condition filter expression. A
filter expression specifies that the contents
(payload or headers) of a message be
analyzed before any event subscription is
sent. For example, you can apply a filter
expression that specifies that an event
subscription be sent only if the message
includes a customer ID. When the expression
logic is satisfied, the event is accepted for
delivery to the integration.

Filter by object name or Filter By Event
Name

Type the initial letters of the name to filter the
display of business objects or event
subscriptions.

Configuring Oracle Sales Cloud Source Request Properties
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Configuring Oracle Sales Cloud Source Response Properties
Enter the Oracle Sales Cloud source response values for your integration.

Topics

• What You Can Do from the Oracle Sales Cloud Source Response Page

• What You See on the Oracle Sales Cloud Source Response Page

What You Can Do from the Oracle Sales Cloud Trigger Response Page
You can configure the operation and business object that comprise the response type
for Oracle Sales Cloud.

• Immediate (synchronous) response: A response business object is immediately
returned as output. You select Immediate as the response type on the Response
page and select the business object as part of the response to the client.

• No response is required: You select None on the Response page because a response
is not required.

What You See on the Oracle Sales Cloud Trigger Response Page
Select the business object for the integration to send as a response document to the
Oracle Sales Cloud application.

The following types of responses are available.

• Immediate: A synchronous response is required (See Table 5-1 for instructions)

• None: No response is required (See Table 5-2 for instructions)

The following table describes the fields available if an immediate (synchronous)
response is required.

Table 5-1    Response Type — Immediate (Synchronous) Response is Required

Element Description

Response Type Select Immediate for the Oracle Sales Cloud
application to wait until a response is
received from the integration. This is also
known as the request and response message
exchange pattern. This is the default
selection.

Filter by object name Type the initial letters to filter the display of
business objects.

Configuring Oracle Sales Cloud Source Response Properties
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Table 5-1    (Cont.) Response Type — Immediate (Synchronous) Response is
Required

Element Description

Select a Business Object Select the business object to receive from the
Oracle Sales Cloud application as a response.
You can filter the display of business objects
by typing the initial letters of business objects
in the Filter by object name field. A
description of the selected business object is
displayed below this list.

The following table describes the fields available if no response is required.

Table 5-2    None — No Response is Required

Element Description

Response Type Select None.

Select a Business Object If you select None, this section is hidden.

Configuring Oracle Sales Cloud Target Operation Properties
Enter the Oracle Sales Cloud target operation values for your integration.

Topics

• What You Can Do from the Oracle Sales Cloud Target Operations Page

• What You See on the Oracle Sales Cloud Target Operations Page

What You Can Do from the Oracle Sales Cloud Target Operations Page
You can configure the following target operations values for Oracle Sales Cloud.

• Browse for and select a business object or service.

• Select the operation to perform on the business object or service.

Configuring Oracle Sales Cloud Target Operation Properties
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What You See on the Oracle Sales Cloud Target Operations Page
The following table describes the key information on the Oracle Sales Cloud target
Operations page.

Element Description

Browse by Select to browse by business object or service.
There is a one-to-one correspondence
between the business object and service. The
service acts on the business document.

• Business Objects: Select to browse a list
of available business objects.

• Services: Select to browse a list of
available business services.

Object Filter Name Type the initial letters to filter the display of
business objects.

Business Objects Select the business object or service to use.

Select the operation to perform on the
business object or service

Select the operation to perform on the
selected business object or service.

Life Cycle Displays the state of the selected business
object or service. Deprecated indicates the
business document is nearing the end of use
and must be used with caution.

Description Displays a description of the selected
business object or service.

Reviewing Configuration Values on the Summary Page
You can review the specified adapter configuration values on the Summary page.

Topics

• What You Can Do from the Summary Page

• What You See on the Summary Page

What You Can Do from the Summary Page
You can review source or target configuration details from the Summary page. The
Summary page is the final wizard page for each adapter after you have completed
your configuration.

• View the configuration details you defined for the source or target adapter. For
example, if you have defined an inbound source adapter with a request business
object and immediate response business object, specific details about this
configuration are displayed on the Summary page.

• Click Done if you want to save your configuration details.

Reviewing Configuration Values on the Summary Page
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• Click a specific tab in the left panel or click Back to access a specific page to update
your configuration definitions.

• Click Cancel to cancel your configuration details.

What You See on the Summary Page
The following table describes the key information on the Summary page.

Element Description

Summary Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard.

For adapters for which a generated XSD file is
provided, click the XSD link to view a read-
only version of the file.

To return to a previous page to update any
values, click the appropriate tab in the left
panel or click Back.

Reviewing Configuration Values on the Summary Page

Configuring Oracle Sales Cloud Properties  5-9



Reviewing Configuration Values on the Summary Page

5-10  Using Oracle Sales Cloud Adapter



6
Managing Applications

This section describes how to manage and monitor an Oracle SOA Suite or Oracle
Service Bus application that uses the adapter from Oracle Enterprise Manager Fusion
Middleware Control or Oracle Service Bus Console.

Topics

• Managing the Application in Oracle Enterprise Manager Fusion Middleware
Control

• Testing Oracle Service Bus Projects from Oracle Service Bus Console

Managing the Application in Oracle Enterprise Manager Fusion
Middleware Control

You manage the SOA composite application or Oracle Service Bus business service
that includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1. Log in to Oracle Enterprise Manager Fusion Middleware Control.

2. In the navigator, expand the tree to display your SOA composite application or
Oracle Service Bus business service project (for this example, a SOA composite
application is selected).

3. Select the SOA composite application.

4. Click Test.

The Test Web Service page is displayed.

5. Complete the fields on the page to initiate a test of your composite.

6. Click Test Web Service.

Invocation results are displayed.

7. Click Launch Flow Trace to view the flow trace of the SOA composite application,
including flow details about the adapter.

For more information about monitoring applications from Oracle Enterprise
Manager Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle
Business Process Management Suite and Administering Oracle Service Bus.
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Testing Oracle Service Bus Business Services from Oracle Service Bus
Console

You can test Oracle Service Bus business service projects from Oracle Service Bus
Console.

1. Log in to Oracle Service Bus Console.

2. In the navigator under All Projects, open the project to test.

3. In the navigator, click the business service for that project.

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint.

This opens a window that displays the proxy service and the operation to test.

5. Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed
under the Response Document section.

For more information about testing Oracle Service Bus business service projects,
see Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service Bus Console
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7
Troubleshooting and Error Handling

This section describes how to troubleshoot and handle errors with the Oracle Sales
Cloud adapter.

Topic

• Avoiding SSL Exceptions in Oracle JDeveloper When Connecting to the Event URL
Using the CSF Key

• Connection to Oracle Sales Cloud Inbound Events URL Fails Using the CSF Key

• Adding Credential Details to the JCA file Before Event-Based Composite
Deployment to the Server

Avoiding SSL Exceptions in Oracle JDeveloper When Connecting to the
Event URL Using the CSF Key

When you define the CSF key while creating an event-based Oracle Sales Cloud
connection in Oracle JDeveloper, you can receive an SSL exception error when you
click the Test button. To avoid this issue, perform the following steps.

1. Open the $JDEV_HOME/bin/jdev.conf file.

2. Add the following:

AddVMOption -Dsun.security.ssl.allowUnsafeRenegotiation=true
AddVMOption -Dhttps.protocols=TLSv1,SSLv3 

3. Restart Oracle JDeveloper.

Connection to Oracle Sales Cloud Inbound Events URL Fails Using the
CSF Key

When you define the CSF key while creating an inbound event-based Oracle Sales
Cloud connection in Oracle JDeveloper, you can receive the following SSL exception
error when you click the Test button.

Unable to establish a secure connection to
https://hostname.us.oracle.com:10614/fndAppCoreServices/ServiceCatalogService?wsdl. 
SSL protocol related exception occurred.
Mar 14, 2016 9:54:51 PM oracle.cloud.adapter.api.util.DefaultLoggerService
logSevere
SEVERE: oracle.j2ee.ws.wsdl.LocalizedWSDLException: WSDLException:
faultCode=PARSER_ERROR: Failed to read wsdl file at:
"https://hostname.us.oracle.com:10614/fndAppCoreServices/ServiceCatalogService?
wsdl", caused by: javax.net.ssl.SSLException.: 
   javax.net.ssl.SSLException:
Received fatal alert: close_notify
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    at oracle.j2ee.ws.wsdl.xml.WSDLReaderImpl.readWSDL(WSDLReaderImpl.java:411)
    at oracle.j2ee.ws.wsdl.xml.WSDLReaderImpl.readWSDL(WSDLReaderImpl.java:728)
    at oracle.j2ee.ws.wsdl.xml.WSDLReaderImpl.readWSDL(WSDLReaderImpl.java:706)
    at 
    oracle.tip.tools.ide.adapters.cloud.impl.service.DefaultWSDLHelperService.getD
    efinitionFromURL(DefaultWSDLHelperService.java:58)
     at
    oracle.tip.tools.ide.adapters.cloud.impl.service.DefaultWSDLHelperService.getE
    ndpointAddressFromWSDL(DefaultWSDLHelperService.java:70)
    at 
. . .
. . .
. . .

To avoid this issue, perform the following steps.

1. Open the $JDEV_HOME/bin/jdev.conf file.

2. Add the following:

AddVMOption -Djdk.tls.client.protocols=TLSv1

3. Restart Oracle JDeveloper.

4. Open the setDomainEnv.sh runtime file.

5. Update the following property:

-Djdk.tls.client.protocols=TLSv1

Adding Credential Details to the JCA file Before Event-Based Composite
Deployment to the Server

While designing the Oracle Sales Cloud adapter event-based service, the credential
details must be populated in the JCA file. If the credential details are not populated in
the JCA file, the event-based composite fails during deployment.

<Nov 30, 2015 5:53:43 PM IST> <Error> <oracle.soa.adapter> <BEA-000000>   
<JCABinding=>  OSCEvent Error while performing endpoint Activation:  
javax.resource.ResourceException: 
oracle.cloud.connector.api.CloudInvocationException: 
oracle.cloud.connector.api.CloudInvocationException:   
oracle.cloud.connector.api.CloudInvocationException: Error: 401 : Cannot get   
the subscription for the id 
. . .
. . .

To avoid this issue, perform the following steps.

1. Update the exposed service-side JCA file with the following details:

<property name="csfkey" value="csfkey"/> 
<property name="csfMap" value="oracle.wsm.security"/>

Adding Credential Details to the JCA file Before Event-Based Composite Deployment to the Server
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